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 This help system is under construction

                                                                      GENERAL TOPICS

 About    

Software License Agreement

Technical Support 

Working    with 256 Color Pictures

Gif shaker



            Play Gif
Play Gif - the movie currently displayed in the movie - player windows.
you just choice anyone file from file menu and click on choosing yours 
file and press Play Gif command.



                  Open
You use    the New command on the File menu to    open new file.
To click on File menu" Open"    will    appear a window with list of
 files. You    choose any one and doubleclick on the name of the

                          file.



                New

                          You use the New button on the AutoBar or the New command 
                          on the File menu to insert a new frame or start a new picture.
                          To insert a new frame from file, select file name from list in 
                          Listbox. You can choose any one ,doubleclick on the filename
                          you    want in the animation..



                                        Paste from the clipboard.
                                      You use the Paste button on the AutoBar or the Paste 
                                      command on theEdit menu to paste a picture from the 
                                      Clipboard onto your picture. 



                  Copy to the clipboard. 

    You use the "Copy to the clipboard" from Command Bar
                                    or from Edit menu to copy a    file.Select the area you want
                                    tocopy and click on Copy from the Edit menu.    Select a drive,
                                    directory    and filename for the file or place you want to paste
                                    this Image.



                      Cut

You use the Cut command on the Edit menu to remove a
cutout from a picture and place it    on the Windows Clipboard.
The cut    area is replaced with the selected background color. 



Menu Edit
* Cut

* Copy

* Paste



MenuFile

* New

* Open

* Save

* Play

* Manipulate Image

* Edit Gifs

* Acquire

* Insert Frames from AVI

* InsertFrames from Live Video



 Menu Bar

* Menu File

* Menu Edit



        Image info

As the Producer, you through the 'Image Info' interface have
                        the ability to change each Frame's Background color,Screen
                        Width, Screen Height and also number of Times the animation
                        is repeated.
          

                                                           
Screen Width --From small screen to Cinematographic

                        big screen effect.
Screen Height --Sets all Frames an equal height.( The

                        logical screen Height )
Net Loops ------- Number of Times to play animation.

                        (0 means non-stop)
Back Color ------- Left Click    to select.

               Right Click to use the palette window to choose the color.
Frames -----------    Total Frames in current animation. (read only)

 



Frame info
              Frame info - gives you opportunity to move 
              your frame to any position of    picture screen
              thus affecting the animation. Position of the
              frame can give    the effect of movement up
              and down    or give a jiggling effect left to Right fo
              example        
              To do this, just click to Frame Left (Up or Down)
              and your    image will be moved.
              Same with Frame Top.
          

                                      1.        Spin Edit Controls
      a.          Move From Left, Move From Top:    Will move

                                                      the image in the frame to a new position.    If
                                                      juxtaposed with original    image it will appear to
                                                      jump.    Therefore, for smoothness and fluidity we
                                                      suggest, having all frames the same width and 
                                                      height and keeping the images in the same position
                                                      in each frame.

    b.  Frame Delay’ will delay the display time for the current
                                                      frame. This gives smoothness or      fluidity of movement. 

                                    2.            Check Boxes 
    a.            Has Transparency’ means that if Box is checked, then

                                                        the background will become transparent, leaving    a
                                                        stand-alone Image.

      b.          Interlaced’ means that if box is checked then the 

                                      3.            Drop Down Menu
                        Disposal Way’    means    how you handle the previous

                                                        image if an overlay occurs.
                        None- Both frames will show if overlapping.
                        Not Dispose-Same as None.
                        Erase- previous frame is not seen.
                        Overwrite- Allows one image to hide the previous image.

        

                              

Frame Left ----------        Left position of the frame
Frame Top ----------- Top position of the frame



Frame Delay --------- Delay in 100 Sec
Has Transparency - Flag indicating that this 
frame has    an transparent color
Interlaced    -------------- Interlaced
Disposal Way -------      How to dispose the previous frame



      Palette info

        The Info palette function has an on-screen gauge
        for reading color density values. You can choose
        two ways to Apply colors on the active window
        density values. You can choose two ways to Apply
        colors on the active window.First,    you can use the
        slider to find colors or    you can choose colors    from
        a palette.    The easy way to do this is to move your
        cursor on thepalette and    choose the color.
        Click on color choice, this color will appear on the 
        small panel.After this,    click on the Color Index Button
        and the existing image will change colors.

a.    3 Slide-Controls to adjust Red, Green and Blue 
            values( 0-255); 
b.    Check Box for ‘Auto Apply Color’- when you move the

                                            slide controls ,color changes automatically in the
                                            displayed image.

c.      Color Index    shows the position of the color in the
                                            displayed palette’s index. If you click on a    square , 
                                            it displays the numerical index of that palette. 

d.    Check Box “Use Own Palette’ allows the use of that 
                                            frame’s palette. 

e.    Icon (square over circle) and Current Color Box work 
                                            together allowing you to make the    ‘Current Color’( in box)
                                            the “Active” color.    Click on any color area in displayed
                                            image, making that color    appear in the color box.    You
                                            may adjust that color using the RG B slider    controls. Click
                                            on Auto Apply    to see an instant change in the displayed
                                              image. 

                                           
                                        

R: - Set the RED component of the color
G: - Set the GREEN component of the color
B: - Set the BLUE component of the color 
Auto apply color - When checked the trackbar
changes are applied to the image
Color Index - Set the current color to the active

                        window color



Use its own color palette - When checked this
 frame will use its own color palette.

                      Set the color to the active window color



                  SkyLine Tools
mail to 72130.353@CompuServe.com
http://www.Imagelib.com/Index.html
1-800-404-3832
Uses Imagelib Corporate Suite
Version Build: 2.07



                                          Auto Contrast

                                The Auto Contrast effect will give you better contrast by making
                                  the darks darker and the lights lighter.      In general, the Auto 
                                  Contrast gives a    good result    when a simple    contrast adjustment 
                                  is needed to    improve an image's contrast.

To create AutoContrast effect you just need to click on
"Contrast on OK" , then click the button.



Bleed

Bleed causes    the image's color palette to expand beyond original
boundries depending on value that you select.The Bleed    marks

                                inside the image instead of outside the image.Use this when you want
                                to intensify    the image within the graphic.
                                The easy way to    Bleed the Image is to use the slider

control to adjust the    RGB Value between    -255 to 255.
To create Bleed Image press "OK".



                                    Border
 

The Border effect creates a matt around the image just like 
                                  the matts you get    behind pictures when you have them framed.
                                  You may manipulate border shape, thickness and color.Choose
                                  from the list below to select the shape of the matt. Then select a
                                  value    from the edge box.. Click border O.K. to apply

 By using the Border effect, you can choose an option from
 the list below, then select an area (drag the mouse) to the 

                                  desired diameter outlining the selection. 

1. Rectangle
2. Square
3. RoundRect
4. RoundSquare
5. Ellipse
6. Circle
7. TriangleLeft
8. TriangleRight
9.    TriangleUp
10. TriangleDown
11. Diamond
12. Star
13. PolyGon

And also can you change Edge from 0 to 60

 



                                    Change Shape Style of Image

In this program it is possible    to change Shape    of image
with 13 different styles.

1. Rectangle
2. Square
3. RoundRect
4. RoundSquare
5. Ellipse
6. Circle
7. TriangleLeft
8. TriangleRight
9.    TriangleUp
10. TriangleDown
11. Diamond
12. Star
13. PolyGon

And also can you change Edge from 0 to 60

 



Border Fade

          Border Fade - You can fade the Image from the
          Border towards the center of    the Image depending 
          on the value selected    from 1 to 300 .    Also, you can
          easily determine the action using the checkerboard
          Board Type since it is a known design.



            Blur    effects

    The Blur    filter softens any hard contrast in the parts
    of the image    where significant color transitions occur.
    The Blur filter smoothes transitions by averaging the
    pixels next to the hard edges of defined lines and
    shaded areas.    Blur by small degrees at first, starting
    at value 10 to check for quality or desired effect.



        Brighten / Darken

 Using the Bright / Dark effect is the easiest way to make
 generalized adjustments to the tonal range of the image.
 For example sliding towards the positive values adds light
 and sliding towards the negative adds blackness. The color
 is reduced as either light is added or darkness added.



Color
You can choose    Color Reduction by these options:

                                                                            -Blayer
                                                                          - Floyed
                                                                          - Burkes
                                                                        - Gray Scale

 and Number of Colors by sliding bar to value desired.
 Test    these different options to give texture and reduce tone.



Curl page
        In Curl page effect    you can adjust the curl by:
    - Shading : You have choice of opacity of shadow in curl
    - Background : You have choice of Foreground color and
        Background color
    - Location : Your page curl can be at any corner 
      -Keeping the curl and adding new curl over first page curl.



Edge Detection

            Use the Edge Detection effect to intensify outlines 
            of high contrast while    darkening areas of low contrast.
            You can set sensitivity of    edge detection by value. 
            Low value determines the amount of edge detection
            of high intensity. 

            To determine    intensity of Edge Detection on your image ,
            choose a Value between 1 to 100 and click "OK". 



Engrave Effects

 To make an    Engraved image ,    choose a Value on the 
 slider control between 1 to 10 and click "OK".        The value
 from 1 (one value) and up to value 10 deletes the color
 and generalizes    areas into high and low tones, the more
 the value the thicker the Engraved line.    



        Enhance effects

                          Use the Enhance filter to augment or decrement
                          RGB values among areas of different colors and
                          shades.

                          On Spin-edit Control    add or delete 
                          - Gamma Red
                          - Gamma Green
                          - Gamma Blue
                          - Bright
                          - Conrast



                                  Gray Area

          Gray effect applied to whole image, the only colors
          are black and white mixed to gray tone.



                      Gamma    Correction

          In Gamma Correction you can make gradual adjustments
          to the brightness, contrast    in an image.        Adjusting the ga-

                                  mma lets you change the brightness values of the middle
                                  range of gray tones without dramatically altering the shadows
                                  and highlights. 

          To make Gamma Correction use slider control    and choose
                                    a Value between 10 to 50. After this click "OK" .      



                          Half Tone

Half tone, the reproduction of a continuous - tone image on
                        a device which does not directly support continuous output. 
                      Thisis done by displaying or printing a pattern of small dots
                        which, froma distance can meld optically to simulate the de-
                        sired output color or intensity.You can change the half tones
                          to
                                                                                                                - Diamond
                                                                                                                  - Line
                                                                                                                  - Cross
                                                                                                                  - Circle
                                                                                                                  - Ellipse
                                                                                                                  - Square

and also it is possible change Pixel Angle and Cell size. 



Invert effects

 The Invert effect reverses the positve and negative areas
                              of an image. You can use this effect to turn a positive into
                              a negative or to create a positive image from a scanned 
                              negative.

To create Invert image just click on" Invert Image" , then
                            click "OK"



              Jiggle effects
        To make a Jiggle effect of image , you just choose a Value 
        and Amplitude using the spin-edit controls and then click "OK".
        The Value controls the squiggle and the Amplitude controls

                                  the stretch or pull effect sometimes doubling or tripling the image.



Mirror Effect

 In mirror effect it is possible to change
 Vertical and Horizontal position of an    image.



Mosaic Effect

              The Mosaic effect clumps pixels into different blocks.
              The cell size is the width of a cell in pixels. The pixels
              in a given block are the same color, and the colors
              of the blocks represent the colors in the selection. 
 
              Mosaic effect - allows you to choose4 different mosaic types:
                                                                                                                - Square
                                                                                                                - Polygons
                                                                                                              -    Smooth
                                                                                                                - Rough
            also you can resize the Height,    Space and Light of the Mosaic.



                      Motion effects

          The Motion effect    blurs the image to reproduce a simulation
          of movement. The effect of this filter is analogous to taking 
          a picture of a moving object with a fixed exposure time. 

        In Motion effect - you can choose 3 different Motion groups:
        * Motion Zoom-the egdes of the border towards the center.
        * Motion Rotate-blurs from the edge to center rotating.
        *    Motion Line-shifts image laterally.



    Oil Paint    

    To simulate an Oil Painting , you just choose Value
    on the slider control between 1 to 100 and click "OK".
    The program merges the pixels to effect    an image

                                    of painterliness.



Punch Hole in Image

The Punch Hole rotates the center image so that the center disappears.
To make Punch Hole in Image use slider control .To adjust size of hole

                                  choose a Value between -20 to 0. After adjusting click "OK"



Pixel Fix

Bit resolution, or pixel fix, is a measurement of the number of bits 
of stored information per pixel. Bit resolution determines how much
color information is available for each pixel in the file. Greater pixel
 fix means more available colors and more accurate color
 representation in the    image.      

To create Pixel Fix adjust slider control Value from 0 to 100 and 
click "OK".



                          Pyramid Extrude
        Pyramid Extrude - creates a waffleiron effect of the image.
        Pyamid Extrude allows you to monitor Size of pyramid using
        spin-edit control from 10 to 30



Rotate Effect

The Rotate effect rotates the image according to the horizontal
 and vertical limits set in the Rotate dialog box. The rotation is
 applied as if the image were three-dimensional.

To Rotate image and choose a different color    backcolor
select Value for degree of rotation and choose background
color from Palette.



Sharpen Image

    The Sharpen effect provides more definition to blurry images
    by applying sharpening only when an edge is found.    The

                                    Sharp effect preserves the overall smoothness of the 
    image and focuses only the edges.    

 Sharpen image - allows    you to make image crisper or duller.
                                  Choose from Values -9 to 9.



Spray Effect

The Spray effect    applies the palette as if from a spray can .
To make Spray image effect , you just choose Value and

                          Random on spinedet controls and after that press "OK".



Tile Marker

To create an image suitable for Tiling
you just click on "Tile on Ok" and click "OK".
The Image is quartered and duplicates of each 

                                                quater are positioned at each corner. 



      Transition Effects
    Radio Buttons - choose transition effect:
* None
* Horizontal- Image is loaded using Horizontal bands.
* Vertical - Image is loaded using Vertical bands.
* Diagonal - Image apears by bands from corner.
* Squares - Image appears as checkerboard.
* Rectangle - Image appears from border to center in bands.
    and on spin-edit control you can adjust    Delay (speed) and

                                    Thickness.
 Thickness can also determine speed.



Whirlpool
    

To make a    Whirlpool    effect in the    image use
slider control Value between 0 to 1000.
 After adjusting, click "OK".



Wave Image

Wave image effect distorts an image somewhat randomly 
but gives you greater control over the results. For example,

                        the Wave effect can be used to create a marbling    or
                        abstract effect as well as a rippling effect.

To create Wave image you can use spin-edit control
 for Phase,Wave Length and Amplitude of    Wave. 





              Threshold effect

Select a value from 0-255 for two color ,everything 
below that value is one color the rest of the image
is that second color.



Manipulate

     
 

32 Different Variant to Manipulate images

AutoContrast
Bleed                                                      
Border

                                                                                                Border Fade
Blur
Bright / Dark
Color
Curl Page
Edge Detection
Engrave
Enhance
Gray Area
Gamma
Half Tone
Invert
Jiggle
Mosaic
Motion
Oil Paint
Pinch Hole
Pixel Fix

                                                                                                Polar Effect
Pyramid Extrude
Rotate
Sharp
Spray
Tile Marker



                                                                                                Threshold
Transitions
Whirl Pool

    Wave Image
 



Toggle between comments and frame editor

 
* Create a new Comment
* Save Current Comment
* Delete Comment
* Load comment from a text file
* Print current comment
* Copy selected text of the comment to the clipboard
* Cut selected text of the coment
* Paste comment from the clipboard

                                                                                * Save comment to text file

 



Select Frames
 

  
    This allows you, the Animated Gif Producer,

                              the ability to edit each frame by these parameters: 

* Top position of the frame-spin-edit button controls 
                                placement of image in frame.

* Left position of the frame-spin-edit button controls
                              placement of image in frame.

* Delay in 100Sec-you control delay time for each frame.
* Disposal - How to edit the    framing sequence.
* Has Transparency - Flag indicating that this frame has

                              a transparent color, choose color.
* Interlaced - interlaced control.
* Use its own palette-Local Palette option.
* Flag the Top to be changed on Apply.
* Flag the Left to be changed on Apply.
* Flag the Delay to be changed on Apply. 
* Flag the Disposal Method to be changed on Apply.
* Flag the Transparent Color to be changed on Apply.
* Flag the Interlaced to be changed on Apply.
* Flag the Palette to be changed on Apply.
* Convert the frame's color palette.
* Apply - Apply this to all selected frames.
* 16 Colors - Downscale frame to 16 colors.
* 256 Colors - Upscale frame to256 colors.
* Bayer - Sets the dither method.
* Burkes - Sets the dither method.
* Floyd - Sets the dither method.
* Gray - Generate a Grayscale Image.



 



Color Palette

Optimize Palette
Best choice . This will generate an optimized palette from the
Current color palette. All selected frames will then be matched
with this optimized color palette.

Copy Palette
Replace the color palette from allselected frames with the current
active color palette. Be aware than this choice can destroy your
frames. 



Text on Image

This program gives you the opportunity to write text on top of the
                image.If you click on the Command button "Text" ,    you will see
                  a sample on top of the image "Text on Image".To create your
          own text,    Right click mouse    on " Text on Image"    to Edit text.On
                Text Form    write your own text,choose font etc.    After this you    click
                  on thebutton "Apply and Commit"This control picks up from text
                  box    your text and transfers it to the image.

         
 

      

 Set the    Font properties
                                                           

                    
 

                Apply and burn the text into the selected frames
                 

                                 

               Apply but doesn't burn it in the image



                          Rotate frame

                      One of the many great things in this program that you 
                      can Rotate images.The Rotate Frame rotates the image 
                      according to the horizontal and vertical limits set in the
                      Rotate dialog box. 

                      Rotates the selected item 360 Degrees to the right.
 

 

                      Stretch Image

                                  Background Color

    Rotate Frame



                          Crop the selected frames

                  You use the Crop command to select part of an image and 
                discard the rest.    Left Click on the image and drag cursor to 
                select an area, then at same time Right Click and release.
                The area is selected to crop.
                All Frame - apply to all selected frames.
              This Frame - apply to current frame only.



Resize

 One of the great things about resize frame is that      you can resize
                          an object without losing image quality.The tools to do this arelocated
                          on the Command Bar. The Resize command is used to create a
                          new image of a different size and/or resolution. The width and height
                          of the image can be adjusted by value or percentage. To Resize an
                          image you use the sliders controls. The Vertical slider controls move-
                          ment up or down and gyrational slider controls movement left or right.
    

             

All Frames - Apply to all selected frames
This Frame - Apply to current frame only



Live Video 

Connec your video camera to your computerl/o ports and
                                download the frames.Make yourhome video worthy of winning
                              "America's funniest video" 10.000 prize.

 
             

            Button                                                                  Description
                                                                                                                  
                                                 Stop 

                                               Delete all capture frames
                                                                                                If some frame are not needed , delete
                                                                                                selected one
                                                Capture a single frame

                                        Choose one frame at a time for smooth
                                                                                                or jerky    transition effects.

                                                         Set video to active

                                                      Preview video
                                                                                              Look at Progress of production



                                                      Use overlay

*    256 Colors -      Generate a 256    Color frames

    *    16 Colors -      Generate a 16    Color frames    



 



                                                                                                       
 VIDEO

        The program allows you,as producer, to add AVI,MOV and
                                            MPEG    sequences from AVI files or from live feed from video
                                            camera .You have the choice to manipulate each frame and
                          change the playing sequences.Saving the animation will
                          create an icon which can be played on your internet browser.
                          Send it to tour frends. Load it on    your web page. Impress    the
                           world.

                                  

             
                                                        
Button                                                  Description

              Open new video dialog Box 
                                                                      To select AVI file you want    to edit or capture
                                                                        sequences from to create a new animation.
                                                                                                                                                                                  
                        Start capture of video frames to gif animation
                                                                        Click here to capture many frames of AVI or MOV
                                                                        or MPEG video that is loaded

                      

                          Stop capture
                                                                          Click here to stop frame grabber .You can begin
                                                                          grabbing again using start or single frame button.



                                                                                                                       

                    Delete all capture frames
                                                                            Edit frames grabbed by selecting frames not wante
                          Capture a single frame
                                                                            Grabs one frame at a time

                      

                     
                                      Video control buttons
                                                                                                                                                                        
        Active controls act like any video player,Play,Rewind etc.

                  .
*      High Quality - Makes the best quality frames
*    Less Quality - Makes less quality frames
*    256 Colors -      Generate a 256    Color frames 

        *    16 Colors -      Generate a 16    Color frames    



Software License Agreement

The software which accompanies this license (ImageLib GifShaker) is the property of    
Creative Development LTD doing business as SkyLine Tools and is protected by federal 
copyright law. Entire contents    (c) Copyright ImageLib GifShaker, 1996, Creative Development 
LTD, 11956 Riverside Drive, Ste. 107, North Hollywood CA 91607.    All rights reserved.    The 
content of this software and its manual is subject to change without notice.    No part of the 
manual may be reproduced either electronically or mechanically without the prior written 
consent of Creative Development LTD.    

GifShaker (tm) 
This License Agreement ( Agreement ) is a legal agreement between SkyLine Tools, a Division 
of Creative Development LTD., hereby referred to in this document as Creative Development, a 
California corporation, principally located at 11956 Riverside    Drive, North Hollywood, CA 
91607, and you, the user ( Licensee ), and is effective the date Licensee installs the package 
containing the diskettes or downloads the files electronically. This agreement applies to all 
versions of the GifShaker 1.0    up to the debut of Version 2.0, at which time, the licensing 
agreement will change and royalties will apply. 

LICENSING 
Creative Development LTD., will    license the GifShaker Suite software to you only upon the 
condition that    all of the terms contained in the license agreement printed below are accepted 
by you.    Please read the terms carefully before installing the program, as installing    the 
programs will indicate your acceptance to all of the terms of this license agreement. If you do 
not agree to the terms, SkyLine Tools will not license the software to you, in which case please 
return the unopened package and all accompanying material to SkyLine Tools or your 
authorized dealer for a full refund within 30 days of purchase. 
 
LICENSEE:
While this license may be in the name of a company, it is up to the company to supervise and 
be responsible for allowing only one programmer to use this license. If during the purchasiing 
period the licensee and, or any of his/her designees    has indicated, either in words or by filling 
out any forms that the number of programmers to be working on this software is more than one, 
it is expected that they will fulfill this agreement by purchasing a license for that number of 
programmers. (Pricing depending on quantity.) 

SOFTWARE MAY ONLY BE LICENSED FOR ONE PROGRAMMER
Licensee may use the Software on one (1) IBM or compatible personal computer which is either
a stand-alone work station or a networked work station that does not permit the software to be 
shared with other networked work stations.    IF LICENSEE WISHES TO USE THE SOFTWARE
ON MORE THAN ONE PERSONAL COMPUTER, Additional copies of the software must be 
licensed.        
 
UPGRADES 
If the Software is an upgrade, it, and the product that was upgraded, constitute a single copy of 
the Software for purposes hereof and the upgrade and product that was upgraded cannot be 
used by two people at the same time. That is to say, that one purchased upgrade equals one 



license only.

REDISTRIBUTABLE PORTIONS OF SOFTWARE 
The Software includes certain runtime libraries and files intended for distribution by Licensee 
within the Application Software to the user of Application Software (Redistributionist). Creative 
Development authorizes the Licensee (and only the Licensee) to reproduce exact copies of the 
files designated as Redistributionist and include such files in the Application Software, provided 
such copies are made from the original diskettes in this package (or a set of back-up copies 
made directly from them) and distribute the Application Software directly or through customary 
distribution channels to end users on a royalty free basis. Licensee may utilize the    sample 
source code    and    examples    contained in the Documentation solely for purposes of 
integrating the Redistributionist into the Application Software.    Licensee may distribute the 
Redistributionist only with and for the sole purpose of executing specific application programs 
comprising an end user application, as herein defined.    Under no circumstances may any 
copies of    Redistributionist be distributed separately by Licensee.    Licensee may not modify or 
alter the Redistributionist or remove any identifying string or copyright notice produced by a 
Redistributive.      
 

RESTRICTIONS 
Licensee may not use, copy (other than for archival purposes only), rent, lease, sell, sublicense,
assign or otherwise transfer the Software or any copy, modification, or merged portion, in whole 
or in part, except as expressly provided for in this Agreement. Licensee acknowledges that the 
Software, in source code form, remains a confidential trade secret of SkyLine Tools, of Creative 
Development LTD. and/or its suppliers and therefore Licensee agrees that it shall not modify, 
decompile, disassemble or reverse engineer the Software or attempt to do so except as 
permitted by applicable legislation.    Licensee shall distribute the Redistributables with the 
Application Software and shall not distribute other files contained in the Software, including, but 
not limited to GifShaker files. Licensee shall not reproduce, copy or transfer any 
Documentation.      Licensee acknowledges that the Software is a confidential trade secret of 
Creative Development LTD. and agrees to refrain from disclosing the Software (and to take 
reasonable measures with its employees to ensure they do not disclose the Software) to any 
person, firm or entity except as expressly permitted herein.    Licensee may not use the Software
to develop an application that directly or indirectly utilizes SkyLine Tools Redistributables 
existing in another application that has been developed by Licensee or some third party.    If 
Licensee wishes to use the Software in a manner prohibited by this Agreement, Licensee should
contact Creative Development LTD. to determine whether a special license may be obtained.      
 
 
LIMITED WARRANTY
THE IMAGELIB GifShaker SOFTWARE CONTAINED EITHER IN THESE FILES OR IN THIS 
BOX IS PROVIDED AS IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED.    THIS INCLUDES, BUT IS NOT LIMITED TO, MERCHANTIBILITY AND FITNESS 
FOR A PARTICULAR FUNCTION.    THE ENTIRE RISK RELATED TO PRODUCT 
PERFORMANCE OR QUALITY IS ASSUMED BY THE USER.    IN THE UNLIKELY EVENT A 
DEFECT IS DISCOVERED, YOU ASSUME THE ENTIRE COST OF ANY REMEDIAL ACTION.  
SKYLINE TOOLS' ENTIRE LIABILITY IS LIMITED TO THE ORIGINAL PURCHASE PRICE OF 
IMAGELIB.    SOME STATES DO NOT ALLOW EXCLUSIONS OF IMPLIED WARRANTIES, 
THUS THE ABOVE EXCLUSIONS MAY NOT APPLY TO YOU.    THIS WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS WHICH VARY FROM STATE TO STATE. Creative 
Development LTD does not warrant the programs contained in this package will meet your 



requirements or that the programs will function in an uninterrupted and error free manor.    
Should the diskettes be damaged or rendered unusable under normal use, Creative 
Development LTD will replace them within the first 90 days at no additional charge.    Evidence 
of purchase (original sales receipt) is required for replacement.    
 

U.S. GOVERNMENT RESTRICTED RIGHTS
All Software and Documentation is provided with restricted rights.    Use, duplication, or 
disclosure by the United States Government is subject to the restrictions as set forth in 
subparagraph 8(1)(ii) of the rights in technical data and computer software clause at DFARS 
252.227-7013. GifShaker, ImageLib and ImageLib @theEdge/ GifShaker are copyrighted by 
Creative Development LTD.    Delphi, Borlandand any other brand or product names are 
trademarks or registered trademarks of their respective holders. 
 

IMPORTANT NOTICE 
GIF and TIFF use LZW compression which is patented by Unisys. By using ImageLIb s GIF and
TIFF Read and Write features, you acknowledge that Creative Development has notified you 
about the LZW patent and will not hold Creative Development liable for any legal actions.    
Please Contact Nathan Cass at Unisys for further information.    His phone number is: (310) 
284-9631. His address is: Unisys 2049 Century Park East Ste.310 Los Angeles, CA 90067.



About    Name

ImageLib GIF Shaker 
by SkyLine Tools

A division of Creative Developement LTD.
11956 Riverside Drive 107
North Hollywood, CA 91607

Sales (800) 404-3832
Technical Support (818) 766-3900

Fax (818) 766-9027
Contract Services (800) 404-3822

CompuServe 72130,353
Internet 72130.353@compuserve.com

http://imagelib.com
Marketing and PR

Jillian Pinsker
Programming

                                                                                                                          Jan Dekkers
Alex Zitser
Charles Ye

                                                                                                                            Ilia Lerner
                                                                                            Mark Swenson 
                                                                                                          Other Products see Website:
                                                                                                            ImageLib.com



Technical Support

 For responsive technical support, please E-Mail
                    your questions to the appropriate person listed 
                    below.    If your question is better explained over
                    the telephone, please call (818)766-9899 and 
                    ask for technical support.    For questions about
                    our latest products, please visit our http site on
                    the internet.    The address is:    http://www.imagelib.
                    com

Technical support
CompuServe 72130,353 or
Internet: 72130.353@compuserve.com or
Tech Line (818) 766-9899

For custom contract services, please E-Mail your
                    requests or call (800) 404-3832 and ask for contract 
                    services.



Installation Instructions

1. Run Setup.EXE from the disk.
2. 16 BIT:    BACKUP YOUR \DELPHI\BIN\COMPLIB.DCL

                                (Better safe than sorry).
        32 BIT: BACKUP YOUR \DELPHI 2.0 \BIN\CMPLIB32.

                                DCL (Better safe than sorry).

3. Copy the IMAGELIB VCL files into the directory containing 
                              your 3rd party added VCLs:    Make a seperate direcory for
                              both the 16 and 32 bit VCL.

4. 16 BIT: Execute Delphi.    From the menu bar in Delphi, select
                              Options\Install components\Add and browse your 3rd party 
                              added VCLs directory. Select PMREG.PAS and press the OK
                              button.

    32 BIT: Execute Delphi.    From the menu bar in Delphi, select 
                              Component\Install\Add and browse your 3rd party added VCLs
                              directory. Select PMREG.PAS and press the OK button.

    
RUN THE DEMOALL.DPR FOR ALL NEW FEATURES

+      The main example project DEMOALL.DPR contains a button
                            for help.    If the help file is not in the same directory as the project,
                            the example might not find the help file.



Save all selected frames to an animated gif

    You use the Save button on the AutoBar or the Save command
            on the File menu toupdate a previously saved image with your
            latest changes. Gif Shaker automaticallyoverwrites the existing
              file with the new version. You should save your work periodically. 

Save Options

* All Frames
* Select Frames only 
* All Frames to individual gif files
* Selected frames to individual gif files
      include comments



 

                                Gif Shaker
                                                                                                                                                                                         

  

Button                                        Description

                  Save changes to the active file.

               Open Edit Gif (When not a Gif file it well be converted)

                  Play the current gif animitation.

        Manipulate      the current gif    
                                                                                                                              

 MenuBar



Working with 256 Color Pictures

        A 256 color picture is made up of 256 solid colors. This mode is
        useful if you are creating pictures to view on-screen or if you don't
        have enough memory for 24 bit color pictures. Gif Shaker automa-
        tically converts a picture with fewer than 256 colors to 256 color when
          you open it.

* You can create, open, save, scan, and edit 256 color pictures with
        Gif Shaker. Colors not supported by your monitor are simulated
        on-screen and the original    detail is retained in your picture.

* The color set in the palette of a 256 color picture defines the colors
            available    for your picture.

*    You can use Palette commands to adjust a single color, range of colors,
          or all the colors in your palette. However,        the picture also will change.

     Some tool types are unavailable for 256 color pictures. In addition, most
          tool types    work best in 24 bit color or gray scale. 

* The Tint Paintbrush, Blend Paintbrush, and Sharpen Paintbrush are
          unavailable    for    256 color pictures.

* The AutoEnhance and Auto commands on the Image menu are
          unavailable for 256 color pictures.

* Diffuse and Remove Spots are the only Filter commands available
          for 256 color.

*    Black Hole, Crumple, Crystallize, Fisheye Lens, Outline, Pixelate,
          and Twist are the only Special Effect commands available for 256
          color picture.

* All Tune commands are available for 256 color pictures with the
        exception of Hue and    Saturation.

*    You can open 256 color pictures in the following formats: BMP, GIF,
          PCX, JPG,TIF    and PNG 

*  You can save 256 color pictures in the following formats: BMP, GIF,
            PCX, ,JPG,TIF and PNG 

      A 256 color picture is made up of 256 solid colors. This mode is useful
      if you are creating pictures to view on-screen or if you don't have
      enough memory for 24 bit color pictures.    Gif Shaker automatically
      converts a picture with fewer than 256 colors to 256 color when
        you open it.



*      You can create, open, save, scan, and edit 256 color pictures
            with Gif Shaker . Colors not supported    by your    monitor are
            simulated on-screen and the original detail is retained
            in your picture.

*    The color set in the palette of a 256 color picture defines the colors
          available for your picture.

*    You can use Palette commands to adjust a single color, range of colors, 
        or all the colors in your    palette. However,    the picture also will change.

* Some tool types are unavailable for 256 color pictures. In addition,
        most tool types work best in    24 bit    color or gray scale. 

* The Tint Paintbrush, Blend Paintbrush, and Sharpen Paintbrush are
          unavailable for 256 color pictures.

* The AutoEnhance and Auto commands on the Image menu are
          unavailable    for 256    color pictures.

* Diffuse and Remove Spots are the only Filter commands available 
          for 256 color.

* Black Hole, Crumple, Crystallize, Fisheye Lens, Outline, Pixelate, and
        Twist    are the only    Special    Effect    commands available for 256 color
          picture.

* All Tune commands are available for 256 color pictures with the exception
        of Hue and Saturation.

* You can open 256 color pictures in the following formats: BMP, GIF, PCX,
        JPG TIF and PNG      

*    You can save 256 color pictures in the following formats: BMP, GIF, PCX, 
          JPG TIF and PNG 



 Save all selected frames to an animated gif

        You use the Save button on the AutoBar or the Save
          command on the File menu to update a previously 
          saved image with your latest changes. Gif Shaker 
          automatically overwrites the existing file with the new 
          version. You should save your work periodically. 

Save Options

* All Frames
* Select Frames only 
* All Frames to individual gif files
* Selected frames to individual gif files
      includes comments.



Insert new frame from file
          You choose the first Icon, "Insert New Frame From File" button
          on the AutoBar or the New command on the File menu to
          start    a new Animated Gifs process .    When you click on" Insert
          new frame from file" a window    will appear with a List box
          of files to select from.    You    choose any one, and click on the file. 
          That will load that image into the display window    giving you the
          choice of insertion or for manipulation of Image.    



 Copy to the clipboard. 

            You use the "Copy to the clipboard" from Command
            Bar or from Edit menu to copy a    file.Select the area
            you want to copy and click on Copy from the Edit menu.
            Select a drive, directory and filename for the file or place
            you want to paste this Image.

    
 



Paste from the clipboard.

          You use the "Paste button" on the AutoBar or the Paste
          command on the Edit menu to paste an Image from the
          Clipboard into your Animated gif.    Save    for each change
            you make to the Animation.



              Acquire Single Image
 

                      Acquire Single Image 
                    This executes the Twain Manager provided by your twain

                            device vendor and acquires a single image.

                    Acquire Multiple Images from Scanner
                    Scans a batch of images and adds them to the animated gif.

                            In order to use this function you need a scanner with an Auto-
                            matic Document Feeder.

                   Acquire Multiple Images from a Digital Camera
                      Acquires a batch of images and adds them to the animated gif.

                              In order to use this function you need a digital camera.



Play GIF
When frames are loaded and you want to see the action or 

                            animation of the frmes with your particular settings, then click 
                          on Play GIF to set the animation in motion.
                       To stop animation, click on the check at the far right, and you'll
                                go back tothe Edit Gif interface.    From there you can add new
                                frmaes or edit the frames to effect the motion or presentation
                                desired.



                    Select a twain acquire source.

Choosethe twain compliant device,digital camera scanner etc.



                        Polar Effect
                                  You are standing on the on North Pole and looking down,
                                  thise view is giveng wiht this effect. The first eye lens is similar



                      Exit

                                                      The exit menu has a close option,choose same first .



                                                            Select all frames

                    Click and drag mouse if more then one frame is wanted



              Move one selected frame down

Click on frame and drag down to new disierd
position on sequence



              
              Move one selected frame up
 
                        Select (highlight) frame by choosing.



 
            Delete selected frames

Click on frame on click and if more then one is to be
deleted. Prese delete button.



Open Gif Shaker

     
     Command Bar

Button                                                    Description

                                                Insert new frame from file    

                                                                                              Save all selected frame to an animated gif 

                                                               Copy to the clipboard. 

                                                          Paste from the clipboard.

                                                               Select a twain acquire source.

                                                                 Aquire single image 
                                                
                                           Make gif sequence from an AVI video file.

                                          Make gif sequence from live video.

                                                                 Resize the selected frames

                                                                 Crop the selected frames.

                                                               Rotate Frame



                                                                                                Write text on top of selected frames.

                                                            Color Palette management options

                                                              Select frames and apply settings.

                                                              Toggle between comments and frame editor

                    Manipulate    the current    image

                                            Play the current gif animitation.            
                                                      

                                                              About SkyLine tools.

                                                              Exit

                                                            Move one selected frame up

                                                          Select all frames
    

                                                          Delete selected frames

                                                          Move one selected frame down
 

                                                      Set the current color to the active window color

    *                                                        Image Info

 *                                                               Frame Info

 *                                                              Palette info 

 



Play GIF
 When frames are loaded and you want to see the action or 

                            animation of the frames with your particular settings, then click 
                              on Play GIF to set the animation in motion.
                          To stop animation, click on the check at the far right, and you'll
                                    go back to the Edit Gif interface.    From there you can add new
                                    frames or edit the frames to effect the motion or presentation 
                                    desired.




